
RELEASE NOTES 

 

D9050DDRC DDR5 Test 

Application Software 
Keysight D9050DDRC Software Version 01.80.6.0 

Release Date: June 2023 

Requirements Category (e.g., operating 

system, Infiniium Software Version) 

Microsoft Windows 10 

11.50.00401 (UXR Series, UXR-B Series), 

6.73.00102 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-Series, 

Z-Series, S-Series, V-Series), 

File Name: SetupD9050DDRC_DDR5_Test_1.80.6.0.exe 

Licenses: Please see the product data sheet on Keysight.com. 

New Features 

- Support UXR-B Series oscilloscope. 

Bug Fixes 

- Resolved the port issue using the Advanced Design System (ADS). 
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Keysight D9050DDRC Software Version 01.80.5.0 

Release Date: April 2023 

Requirements Category (e.g., operating 

system, Infiniium Software Version) 

Microsoft Windows 7, Microsoft Windows 10 

11.50.00102 (UXR Series), 

6.73.00102 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-Series, 

Z-Series, S-Series, V-Series), 

File Name: SetupD9050DDRC_DDR5_Test_1.80.5.0.exe 

Licenses: Please see the product data sheet on Keysight.com. 

Modification 

- Update Keysight License Manager 5. 
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Keysight D9050DDRC Software Version 01.80.3.0 

Release Date: December 2022 

Requirements Category (e.g., operating 

system, Infiniium Software Version) 

Microsoft Windows 7, Microsoft Windows 10 

11.30.00601 (UXR Series), 

6.73.00102 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-Series, 

Z-Series, S-Series, V-Series), 

File Name: SetupD9050DDRC_DDR5_Test_1.80.3.0.exe 

Licenses: Please see the product data sheet on Keysight.com. 

Bug Fixes 

- Resolved the issue of unexpected test run abort when performing the Stressed Eye tests 

using the Advanced Design System (ADS). 

- Resolved the issue where the scope timeout used when running the Stressed Eye tests are 

not consistent. 

 

Known Defects 

- The “Auto” option for the RemoveScopeRJ_Mode feature may not work correctly when 

running the Stressed Eye tests with the scope sampling rate option set to “MAX”.  

Workaround for this issue is to configure the scope sampling rate option to use the 

maximum supported value applicable when the adjacent channels of the scope are 

enabled. 
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Keysight D9050DDRC Software Version 01.80.0.0 

Release Date: September 2022 

Requirements Category (e.g., operating system, 

Infiniium Software Version) 

Microsoft Windows 7, Microsoft Windows 10 

11.30.00502 (UXR Series), 

6.71.00001 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series, S-Series, V-Series), 

File Name: SetupInfDDR501800000.exe 

Licenses: Please see the product data sheet on Keysight.com. 

New Features 

- Updated test references according to JESD79-5B specification.  

- Added new tests. 

TestID 10100 [ SRIdiffR_CK ] 

TestID 10105 [ SRIdiffF_CK ]   

TestID 19100 [ Vix_DQS_ratio] 

TestID 14060 [  tDQSH_pre] 

TestID 14070 [ tDQSL_pre]   

TestID 14081 [tDQSL2PRE]   

TestID 14082 [tDQSL3PRE] 

TestID 14083 [tDQSL4PRE] 

TestID 14031 [tWPRE2] 

TestID 14032 [tWPRE3 

TestID 14033 [tWPRE4] 

TestID 14041 [tWPST_0_5] 

TestID 14042 [tWPST_1_5] 

- Enabled Stressed Eye tests in Offline test mode. 

 

Modifications 

- Updated the default value of the JitterTest_BER_Level and SESTest_BER_Level config to 

"1E-9". 

- Updated the Vix_CK_ratio test (TestID 11100) to use the VRMS approach when performing 

the measurement. 

- tWPRE (14030) and tWPST (14040) tests are removed to be consistent with the JESD79-

5B specification.  
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- Updated the availability of the tDQS2DQ test based on the Test Mode config option. 

- Enhanced the preamble and postamble detection for the Read and Write burst data 

processing. 

- Updated the default automation scripts used in the DUT Automation feature. 

 

Bug Fixes 

- Resolved the issue of unexpected test run abort when performing the Stressed Eye tests. 

- Resolved the issue of incorrect test result reporting for the Jitter tests and Stressed Eye 

tests when the auto scope jitter removal feature is enabled. 

- Resolved the issue where the tRPST test is not able to correctly identify the postamble 

region when the Read Postamble mode is set to 1.5tCK.  

 

Known Defects 

- The “Auto” option for the RemoveScopeRJ_Mode feature may not work correctly when 

running the Stressed Eye tests with the scope sampling rate option set to “MAX”.  

Workaround for this issue is to configure the scope sampling rate option to use the 

maximum supported value applicable when the adjacent channels of the scope are 

enabled. 
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Keysight D9050DDRC Software Version 01.70.0.0 

Release Date: Dec 2021 

Requirements Category (e.g., operating system, 

Infiniium Software Version) 

Microsoft Windows 7, Microsoft Windows 10 

11.20.00101 (UXR Series), 

6.70.00101 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series, S-Series, V-Series), 

File Name: SetupInfDDR501700000.exe 

Licenses: Please see the product data sheet on Keysight.com. 

New Features 

- Added support for the “DIMM Rank” option when using the DUT automation feature.  

- Added the “MultiStep” option of the Auto-DCA algorithm under the “DCA auto-

optimization type” section.  

- Added a configuration option (Debug only) for specifying a user-defined path for all the 

DUT Automation control scripts.  

- Added an option for setting the method to determine the VrefDQ measurement threshold 

used in the DQ Jitter tests and Stressed Eye tests.  

- Added the DUT Automation feature support for DQS and DQ Duty_UI tests.  

Modifications 

- Updated the CDR setup procedures for all the tests that use the Infiniium clock recovery 

feature to ensure that the CDR setting is applied to the expected source data.   

- Added new test reporting items to report the DFE Tap values when running the Stressed 

Eye tests.  

- Disabled the InifiniiSim Graph during test run when the InfiniiSim feature is enabled for 

better test time optimization.  

Bug Fixes 

- Resolved a project loading issue in which the app would prompt a warning about being 

unable to restore some configuration variables when the saved project contained some 

Clock Jitter test results.  

- Resolved an issue with incorrect placement of the measurement marker during a test run.  

- Resolved an issue in which the "ContData_VrefDQ_ThresMode = Auto" mode is not being 

applied when performing the DQ Auto-DCA optimization.  

- Resolved an issue in which the “DataPattern” setting value under the DQ Signal operation 

mode option is not being persisted when loading from a saved project file.  
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- Correction of test limit values for the following tests:  

o All the Eye Width tests under the Stressed Eye tests group  

o tCIVW Margin  

o vCIVW Margin  

o CA VIHL(ac)  

- Resolved the issue of using incorrect DUT Automation setting (DCA Step for DQ) during a 

test run when the DCA Mode is set to "Manual" for the DQ signal.  

- Resolved an issue of setting incorrect VrefDQ_threshold for the equalized data when the 

DFE mode is enabled while running the Stressed Eye tests. 

Known Defects 

- The tRPST test is not able to correctly identify the postamble region when the Read 

Postamble mode is set to 1.5tCK.  

- The “Auto” option for the RemoveScopeRJ_Mode feature may not work correctly when 

running the Stressed Eye tests with the scope sampling rate option set to “MAX”. A 

workaround for this issue is to configure the scope sampling rate option to use the 

maximum supported value applicable when the adjacent channels of the scope are 

enabled. 
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Keysight D9050DDRC Software Version 01.60.0.0 

Release Date: July 2021  

 

Requirements Category (e.g., operating system, 

Infiniium Software Version) 

Microsoft Windows 7, Microsoft Windows 10 

10.25.00902 (UXR Series), 

6.60.00403 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series, S-Series, V-Series) 

File Name: SetupInfDDR501600000.exe  

Licenses: Please see the product data sheet on Keysight.com. 

New Features 

- Added DUT Automation and DCA(Duty Cycle Adjuster) feature. These feature are for 

evaluation purpose only.  

- Added DFE mode feature for Stressed Eye tests group.  

- Added new test: tDQS2DQ[Test ID: 14050]  

- Added DQ delay offset mechanism for Write Burst tests group.  

- Updated test references according to JESD79-5 specification.  

Modifications 

- Test Name change for Test ID 13000: SRIdiffR to SRIdiffR_DQS  

- Test Name change for Test ID 13005: SRIdiffF to SRIdiffF_DQS  

- tDQSS test is removed as this test is not testable based on the definition in the JESD79-5 

specification.  

Bug Fixes 

- Correction of report item labels of slew rate transition time for SRQseR(Test ID:13540) and 

SRQseF(Test ID:13545).  

- Correction of test limit value of tCK_1UI_Dj_NoBUJ test (Test ID:15401).  

- Resolved a test abortion issue in Jitter test group. This issue would be seen when running 

in offline mode with the configuration of JitterTest_UIWidthCheck set to "On". 

- Resolved an issue in the "CA4+Burst Latency" feature of the Burst Triggering Method, 

because of which a burst could not be detected.  

- Resolved an issue because of which Auto Scope RJ calibration mode would not work 

properly if the InfiniiSim feature was enabled.  

- Resolved the performance issue of Clock Jitter tests on UXR oscilloscopes, which would 

result in very long completion times for the measurements.  
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- Resolved wrong result unit issue of tDQSCK test, which reported the value in seconds. It 

has now been corrected to the tCK unit.  

Known Defects 

- DFE Auto Tap Optimization feature does not work correctly in UXR-series oscilloscope. 
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Keysight D9050DDRC Software Version 01.50.0001 

Release Date: Jul 2020  

Requirements Category (e.g., operating system) Microsoft Windows 7, Microsoft Windows 10 

Requirements Category (e.g., minimum 

instrument software Version) 

06.55.00504 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series), 

10.25.00902 (UXR-Series) 

File Name: SetupInfDDR501500001.exe  

Licenses: Please see the product data sheet on Keysight.com. 

New Features 

- Support KSF-IPC 3.0 and cdm-protobuf 3.1 communication protocol for configuring and 

running tests using the Advanced Design System (ADS).  
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Keysight D9050DDRC Software Version 01.50.0000 

Release Date: Jun 2020  

Requirements Category (e.g., operating system) Microsoft Windows 7, Microsoft Windows 10 

Requirements Category (e.g., minimum 

instrument software Version) 

06.55.00504 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series), 

10.20.00503 (UXR-Series) 

File Name: SetupInfDDR501500000.exe  

Licenses: Please see the product data sheet on Keysight.com. 

New Features 

- Support for configuring and running tests using the Advanced Design System (ADS).  

- Added new UI width checking feature that is applicable to all the Jitter tests.  

- Added the "Auto" option in the scope jitter removal feature that is applicable to all Jitter 

tests and relevant Stressed Eye tests (Eye Width tests).  

Modifications 

- The test name of TestID 15000 has been changed from "fCK" to "tCK".  

Bug Fixes 

- Fixed issue where the following tests considered an incorrect worst case value as the final 

test result.  

o VILdiff.CK(AC)  

o VILdiff.CK(DC)  

- Fixed issue where WFM file loading failed when using the new WFM format in Infiniium 

baseline version 10.20 and above.  

- Fixed issue where the remote access for the “optSignalSrcOpMode_DQ” configuration is 

not available.  

- Fixed issue where single-ended clock tests are not reporting the correct measurement 

results when performing multi trial testing in a single test run.  

Known Defects/Missing Features  

- For certain versions of the Infiniium Baseline (such as v6.50.01004), the marker location, 

displayed on the reported screenshot, may be slightly offset in resolution by a few pixels.  

- The report parameter labels for the rise/fall time measured in the SRQse tests are 

incorrect.  
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Keysight D9050DDRC Software Version 01.10.0001 

Release Date: Jun 2019  

Requirements Category (e.g., operating system) Microsoft Windows 7, Microsoft Windows 10 

Requirements Category (e.g., minimum 

instrument software Version) 

06.40.00714 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series), 

10.10.04514 (UXR-Series) 

File Name: SetupInfDDR501100001.exe  

Licenses: Please see the product data sheet on Keysight.com. 

New Features 

- Supports PPKS license model. Product name changed from “N6475A DDR5” to 

“D9050DDRC DDR5”.  

Modifications 

- Added support for DQ Stressed Eye tests.  

- Added support for Scope RJ removal feature when running Jitter and Stressed Eye tests.  

- Added support for multi-acquisition feature when running Jitter and Stressed Eye tests.  

- Added the new configurations for Jitter and Stressed Eye tests to support the RJ/RN 

Report options when the RJ/RN method is set to "Spectral & Tail Fit".  

- Updated the signal thresholds used in the Jitter tests, for the CK_diff and DQS_diff will be 

using 0V reference with hysterisis and for DQ will be referring to the VrefDQ config.  

- Updated the DQ NUI Jitter tests to have similar implementation as the DQS NUI Jitter 

tests where it will only process the DQ signal only.  

- Added new DQ Signal Operation Mode option under the DDR5 General Setup window to 

filter tests based on "DataPattern" or "Continuous1010" mode.  

- Removed the "JitterTest_DQS2DQ_Skew_Off" config as it is no longer applicable for any 

tests.  

- Added the new test IDs to cater for individual Clock NUI Jitter tests (1UI to 30UI).  

o Test ID range for tCK_xUI_Rj_NoBUJ is from 15301 to 15330.  

o Test ID range for tCK_xUI_Dj_NoBUJ is from 15401 to 15430.  

o Test ID range for tCK_xUI_Tj_NoBUJ is from 15501 to 15530.  

The previous Clock NUI Jitter tests are removed and replaced by the above-

mentioned new tests.  

- Added the new test IDs to cater for individual DQSNUI Jitter tests (1UI to 4UI) and DQ NUI 

Jitter tests (1UI to 4UI).  

o Test ID range for tTX_DQS_xUI_Rj_NoBUJ is from 16301 to 16304.  

o Test ID range for tTx_DQS_xUI_Dj_NoBUIJ is from 16401 to 16404.  
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The previous DQS NUI Jitter tests and DQ NUI Jitter tests are removed and 

replaced by the above-mentioned new tests.  

- Added the feature to support single-ended CK or DQS input signal when running the Jitter 

tests and Stressed Eye tests.  

- Added new VIHdiff_DQS and VILdiff_DQS configuration under the Threshold Setup 

window.  

- Changed configName for VOHdiff_DQS from “VOHdiff_ac” to “VOHdiff_ac_DQS”.  

- Changed configName for VOLdiff_DQS from “VOLdiff_ac” to “VOHdiff_ac_DQS”.  

Bug Fixes 

- Fixed issue where the option to configure InfiniiSim thresholds is available eventhough the 

feature is disabled after starting a new project file.  

- Fixed test run issues when InfiniiSim feature is enabled.  

- Fixed test reporting issue for tCIVW/vCIVW test where the “Maskless screenshot” reported 

is incorrect when running in a UXR scope.  

Known Defects/Missing Features  

- Does NOT support backward compatibility due to change of test IDs. User will have to save 

previous project files as Settings Only before loading the project in the current software to 

access all the supported configurations. [File->Save Project (Settings Only) As...].  

- No message will be prompted when user selected “Tools-> Infiniium -> InfiniiSim…” or 

“Tools-> Infiniium -> PrecisionProbe/PrecisionCable…” feature without installing the 

required license.  

- Remote access for the “optSignalSrcOpMode_DQ” configuration is not available. 
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Keysight N6475A Software Version 01.00.0000 

Release Date: 08 Feb 2019  

Requirements Category (e.g., operating system) Microsoft Windows 7 

Requirements Category (e.g., minimum 

instrument software Version) 

06.30.00701 (9000 Series, 90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series), 

10.00.04101 (UXR-Series)  

File Name: SetupInfDDR501000000.exe  

Licenses: Please see the product data sheet on Keysight.com. 

Initial Release 

Known Defects/Missing Features 

- Some user configurations inputs from the Setup Tab windows may not properly get 

registered in the application when new custom values are being entered for the first time. 

A workaround fix for such scenario will be to reopen the Setup Tab windows that contain 

the corresponding user configurations before running the selected tests.  

- The DDR tests may not work properly when the probe external scaling feature is used in 

the UXR-Series scope. This is due to a known issue in the scope where the signal 

conditioning of an input channel is not working under certain probe external scaling 

settings. 

 

 

 


